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Outline

●  the Bipolar Junction Transistor (BJT), look at the blackboard...

●  basic usage of PSpice 'on fly'

●  lab. experience #8  -  BJT characteristic curves  

●  lab. experience #9  -  NPN common-emitter amplifier   
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The first transistor (1947)

J. Bardeen W. Shockley W. Brattain

1956 Nobel prize in Physics 

“for their researches on semiconductors 
and their discovery of the transistor effect”

Uhm.... 
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SPICE and PSpice 
●  Simulation Program with Integrated Circuits Emphasis, SPICE 

●  'schematic' is a meaningless word for a computer, just a human graphical visualization of the circuit 

●  a sort of interpreted 'markup' and programming language with its own syntax, a plain text input file and            
  another plain text output file

●  netlist and analysis directives are now automatically generated using graphical interfaces

●  the description of a circuit using the SPICE language is called netlist 

●  SPICE file  =  netlist  +  electrical models  +  analysis directives 

●  Personal SPICE, PSpice is  commercial graphical front-end for personal computers running MS Windows  
  operating systems

●  the student version is free, of course with some limitations 

●  installation details are in the backup section
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●  Capture  -  schematic entry tool

PSpice student

●  PSpice A/D  -  analog, digital and mixed-signals circuit simulator

●  PSpice Model Editor  -  edit plain text SPICE models or extract models from data sheets

●  PSpice Stimulus Editor – graphical editor for time-based waveforms

Be sure to always run Capture with high 
privileges! Pspice simulation files require    
some (not well defined...) write privileges
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Getting started

The Session Log keeps trace of your work... and highlights possible errors ! 
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Create a new project
●  your work is organized into projects  ( .opj main file)

●  specify a new folder in C:\pspice\projects with the same        
  name of the project

●  simulations with PSpice are available only if you choose the     
  Analog or Mixed A/D option

File → New → Project...
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log file

schematic windowproject
 manager

The graphical interface
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Part I
Schematic entry
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Place components
Place → Part...

●  symbols of electrical components are organized into libraries

●  the first time you are using PSpice you have to import the basic libraries



11

Basic libraries

●  ANALOG contains ideal R, L, C and controlled   
  voltage/current sources 

●  BREAKOUT contains ideal semiconductor devices      
 (transistors, diodes etc.)

●  EVAL contains a list of real semiconductor devices           
  (diodes, transistors, logic gates, OPAMP etc. )

●  SOURCE  contains ideal voltage and current sources 
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NPN 2N2222
Check the datasheet!

A general-purpose commercial BJT
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NPN TIP31
Check the datasheet again!

This should be the transistor available for your experimental measurements in lab... 

Another general-purpose commercial BJT
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You can place multiple instances of the same component, press ESC or right click → End Mode to come back 
to the select mode 

EVAL lib → Q2N2222
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To select a component just left click on it

right click an choose Rotate

SOURCE lib → IDC

SOURCE lib → VDC
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Components are on the table, now we have to make connections...
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Make connections
Place → Wire...

left click at the start point and left click again at end one
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Place grounds
●  at least one node MUST be named 0 for the common reference voltage (floating-node errors otherwise)    
●  Place → Ground...     
●  use for instance  CAPSYM /GND symbol but change Name into 0 !      
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Edit instance properties

●  each component has a set of related properties and parameters     

●  some properties names/values are displayed in the schematic, some others by default are shadowed   
  

●  a property/parameter has a name and a value     

●  left click to select a component, then  right click → Edit Properties...     
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For a better visualization choose 
the Pivot view (right click on the 
top-left square in the table) 
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Don't forget to left click on  Apply 
to make changes effective  
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SPICE SI units and prefixes

name SI SPICE C/C++ style

tera T T, t 1e12, 1E12

giga G G, g 1e9, 1E9

mega M MEG, meg 1e6, 1E6

kilo k K, k 1e3, 1E3

milli m M, m 1e-3, 1E-3

micro µ U, u 1e-6, 1E-6

nano n N. n 1e-9, 1E-9

pico p P, p 1e-12, 1E-12

femto f F, f 1e-15, 1E-15

●  SPICE is not case-sensitive, upper case and lower case letters are equivalent

●  be careful not to use M for mega! 15Mohm are 15 milliohm for SPICE 
●  the unit name can be neglected, hence 10 and 10V are equivalent for SPICE  

●  numerical values and prefixes must be typed without spaces, e.g.  10uF, 10u, 10e-6, 10E-6f   
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Place → Net Alias...

Naming nets

Give a name (net alias) to most 
significant nodes of the circuit !  
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Back to the ground...

Just to remind us that the emitter is tied to zero... 
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Complete schematic

Vcc = Vce      
Vbe     
 

Ib      

Ibb      

Ic      
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Capture shortcut description

P place part

Ctrl + A add library

G place ground

F place power

Ctrl + E edit component properties

W place wire

N place net alias

J place junction

ESC end mode

R rotate component

H / V mirror horizontally/vertically

T place text

I /O zoom in/out

Ctrl + X / Ctrl + V cut/paste

DEL, CANC delete component

Useful shortcuts
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Part II
Simulations ! (and more theory...)
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Voltage and current markers

●  put voltage markers on wires   
●  put current markers on pins   

PSpice → Markers → Voltage Level / Current Into Pin
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Simulation profiles
PSpice → New Simulation Profile

●  transient analysis 

●  DC sweeps 

●  frequency (AC) analysis

●  bias point
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Bias point
  large signal DC solution for a particular input voltage/current condition       

   automatically computed in any other simulation     

●  sources with time specifications are set to zero

  the time is removed from the circuit     

●  all capacitors are considered open circuits, all inductors shorts

●  DC analysis is a particular case of transient analysis (dv/dt = 0, di/dt = 0)

   simulation results are printed in the text output file and can be visualized in the schematic using   
   bias point markers  

●  list of all node voltages, currents and total power dissipation
●  detailed bias point information for semiconductor devices  (not included by default)
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DC sweep

  large signal steady-state circuit DC response when sweeping a voltage/current source, a global    
 parameter, a model parameter or the temperature over a range of values      

  the bias point is calculated for each value of the sweep       

  nested DC sweep analysis can be performed       
●  a secondary sweep variable can be selected after a primary sweep value has been specified

●  curve families are obtained
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Vbe vs Ibb (Vce = const)

Is it in agreement with our expectations ?
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Export the plot image

Choose the color scheme, then open your favorite image 
editor (Paint works fine) and simply do a 'paste' inside it   

Window → Copy to Clipboard...



35

Export numerical values

●  the waveform can be exported as a set of (x,y) numerical values

●  select the waveform name at the bottom-left of the window, then Edit → Copy
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●  open a  text editor (Notepad works fine)

●  simply do a 'paste' inside the text editor

●  save the file with the .csv extension, it can be opened with Excel, Mathematica, ROOT etc.
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Welcome to the real world...

Vcc = Vce      

Vbb     
 

Ib      

Vbe     
 

Rb Ib    
 

This is the circuit you have to deal 
with in the lab experience  #8 !

Ic      
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Bias point analysis

PSpice → Bias Points → Enable Bias Current (Voltage) Display 
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Vbe vs Vbb (Vce = const)
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Vbe vs Ib (Vce = const)

Change the x-axis variable in order to 
plot Vbe versus the base-current again

●  IB(Q1)
●  IC(Q1)
●  IE(Q1)

Plot → Axis Settings...
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Vbe vs Ib (Vce = const)

When Vbe reaches ~700 mV the transistor is in full conduction regime !

Input characteristic,  Vbe = f(Ib)
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Ic vs Vce (Vbe = const)
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Ic vs Vce (Vbe = const)Output characteristic,  Ic = f(Vce)
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Nested DC sweeps

Primary sweep by varying Vcc for a fixed 
value of Vbb (and therefore of Vbe) 

The primary sweep  is repeated for different 
values of Vbb (and therefore of Vbe)

N.B. 
The simulation profile is just one, don't create two 
different profiles !
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Ic vs Vce for different Vbb 

Vbb = 1V

Vbb = 2V

Vbb = 3V

Vbb = 4V

Vbb = 5V

What's happening?
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Ic vs Vbb (Vce = const) 
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Ic vs Vbb (Vce = const) 
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Ic vs Ib (Vce = const) 

The relationship between Ic and Ib is linear !

Change the x-axis variable....
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h
FE

 = Ic/Ib vs Ib (Vce = const) 
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h
FE

 = Ic/Ib vs Vbb (Vce sweep) 

Vcc = 1V

Vcc = 10V
Vcc = 7V
Vcc = 4V
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Temperature sweep

T = 0 oC

T = 25 oC

T = 50 oC

T = 100 oC
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Temperature sweep

T = 0 oC

T = 25 oC

T = 50 oC

T = 100 oC

h
FE

 increases with the temperature... does it make sense?
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Vce = Vce1 Vce = Vce2

Ib [μA] Vbe [mV] Ib [μA] Vbe [mV]

... ... ... ...

... ... ... ...

Lab measurements

...

...

...

...

●  input characteristics  →  Ib vs Vbe, Vce = const

●  output characteristics  →  Ic vs Vce, Vbe = const

Ib = Ib1 Ib = Ib2

Ic [μA] Vce [mV] Ic [μA] Vce [mV]

... ... ... ...

... ... ... ...
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Part III
NPN common-emitter amplifier
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NPN common-emitter amplifier

Vcc      
Vce = Vout      

Vbb = Vin      

Ib      

Ic      

Rc Ic    
  

Vbe     
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Voltage Transfer Characteristic (VTC)

Rc = 1k 

interdiction (cutoff) → active → saturation
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Increasing the load

Rc = 10k 

interdiction (cutoff) → active → saturation
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Rc = 10k 

Ic vs Vbb

interdiction (cutoff) → active → saturation
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Ic vs Vce... the load line !

Ic = Vcc/Rc – Vce/Rc 
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DC operating point

Vin,DC ≈ 1V → Vout,DC = Vcc/2 = 6 V
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●  a first DC analysis determines the initial circuit  bias conditions

●  a smaller integration time step increases both the results accuracy and the simulation duration

  you can specify in the simulation settings window the maximum step size in incrementing the time during             
  transient  analysis (numerical integration time-step) 

●    numerical integration  of a non linear differential equations system

  large-signal response of the circuit to one or more time-dependent inputs

  voltages and currents are tracked over time

●  sometimes convergence problems can occur 

Transient analysis
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VSIN source

●  DF →  dump factor 
●  FREQ →  frequency 
●  PHASE 
●  TD →  delay 

●  VAMPL →  amplitude 

●  VOFF →  DC level 
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Transient analysis

VOFF = Vin,dc = 1V, equal to 
the input DC operating point !

Choose a duration ~ 2/FREQ and     
an integration time-step of 10-100 ns 
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Transient analysis

The circuit is an inverting amplifier !

Vin

Vout

Av = ΔVout / ΔVin ≈ 14 

VAMPL = 100 mV
FREQ = 1 kHz
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Increasing the amplitude

Vin

Vout

VAMPL = 300 mV
FREQ = 1 kHz
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Output saturation

VAMPL = 500 mV

Are you surprised ?

Vin

Vout

FREQ = 1 kHz



67

Increasing the frequency 

Note that a phase difference exist !

FREQ = 100 kHz

Vin

Vout

VAMPL = 100 mV
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Increasing the frequency 

FREQ = 1 MHz

Vin

Vout

VAMPL = 100 mV
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  the sweep can be linear, logarithmically by decades or logarithmically by octaves

●  all independent voltage and current sources that have AC specifications  are inputs to the circuit

●   non-linear devices (diodes, transistors etc.) are linearized to determine their AC small-signal models

  small-signal frequency response of the circuit linearized around the bias point by sweeping one or  
  more AC sources over a range of frequencies 

   outputs include voltages and currents with magnitude and  phase

  the best way to use AC sweep analysis is to set the source magnitude to one  (e.g. ACMAG = 1V, AC=1A )    
  in this way the measured output equals the voltage/current gain (relative to the input source) at that output 

AC analysis 
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VAC source 

●  ACMAG →  amplitude 
●  DC →  DC level (offset)
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AC analysis 

Remind ! 
The AC analysis is a small signal analysis! The circuit is linearized around the DC operating point, hence you can  
use any ACMAG value! By using ACMAG=1V you immediately obtain the voltage gain plot with Vout(f)= Vout(f) /1V 
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Vout/Vin frequency response

 The voltage gain decreases by increasing the signal frequency → low pass filter !

Av ≈ 14 → 
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dB voltage gain

PSpice → Markers → Advanced → dB Magnitude of Voltage

You can plot dB voltages and currents 
and phases using special markers 
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dB voltage gain
BW ~ 10 kHz 

Av ≈ 14  →  20Log Av ≈ 23 dB 
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Backup
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Installation details 
●  download the Windows program executable  91pspstu.exe  (~27 MB) and put it in C:\pspice     

http://personalpages.to.infn.it/~pacher/pspice/91pspstu.exe 
www.electronics-lab.com/downloads/schematic/013/index.html 

●  create a main installation directory  C:\pspice

●  the executable is a self-extractor compressed file, create a  C:\pspice\tmp temporary directory          

  for the extracted installation files and launch the 91pspstu.exe executable      
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●  when the extraction process has finished launch the Setup.exe installation program in the temporary directory

●  choose Capture as schematic entry tool



78

●  change the default installation directory path into C:\pspice
●  this is a safer choice because there are no blanks in the installation path !
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If you want to learn more about this student version of PSpice (e.g. limits in the number of components) 
read the Release Notes
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●  at the end of the installation process delete the 91pspstu.exe file and the temporary directory

●  create a further C:\pspice\projects directory that will contain all your PSpice projects 
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